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.............BRIEFS-------------
NEW CAR POOL REQUEST ON WEB 

REPLACES PRIME SHOWCARS 
PROGRAM

Starting Monday, August 14, you will be 
able to locate available station fleet vehicles 
through the World Wide Web. This new facility 
will replace the Prime computer SHOWCARS 
program. SHOWCARS will be removed from 
the Prime at 4:00 pm on Friday, August 18. If you 
use the SHOWCARS program, you should spend 
a few minutes trying out the new web car pool 
page early in the week.

To use the car pool web page you will 
need Netscape, accessible with the “World 
Wide Web” button in Bear Access on your 
Macintosh. If you don’t have Bear Access, 
contact the Computer Center at x289 for assis
tance with installing it. To get to the car pool 
page, using Netscape go to the NYSAES home 
page (http://www.nysaes.cornell.edu) and click 
on the "D epartm ents” button to bring up a 
new page. On the new page, click on “Build
ings & Properties” under the Support Units 
heading. The Buildings & Properties page 
will appear. C lick on “car pool web page” 
on the new page. If you prefer, you can 
instead access carpool directly with the URL 
http://turtle.nysaes.cornell.edu: 1005/carpool/ . 
No matter how you get there, once you ’ ve located 
the car pool page, you can save a bookmark to 
make it easier to locate it again; do this by 
selecting “Add Bookmark” from Netscape’s 
“Bookmark” menu.

To search for available and reserved ve
hicles, bring up the car pool page in Netscape, 
and fill in two dates (one in each box on your 
screen) to look for vehicles between. Click on the 
“Find Vehicles” button and you'll be taken to a 
page listing the vehicles which are available for 
all the days that are bracketed by the dates you 
entered. The page also includes a listing of all the 
vehicle reservations that fall at least partly be
tween the dates you selected.

While you should use the new web page to 
check for fleet vehicles, you should continue to 
make reservations in the normal way, through a 
contact in your department. The car pool web 
page can only be viewed from NYSAES comput-

HOME LAWN GRUB STUDY CONTINUES

Jennifer G rant, IPM A rea Specialist,
Michael Villani and Jan Nyrop, o f the 
NYSAES entomology departm ent, will 

be studying grubs in home lawns during 
August in a continuation of a study they 
began in 1990.

“It will be interesting to see how the 
drought will affect ’95 grub populations,” 
com m ented Grant. She speculated that the 
weather during the rem ainder o f August 
may turn out to be more of a factor in 
determ in ing  grub popu la tions than the 
drought o f previous weeks.

No sampling plan or control decision 
rules for managing scarab grubs were avail
able prior to this study. Instead, preventive 
insecticide sprays were often adm inistered 
in a wholesale fashion by turf managers.
Accordi ng to data gathered by Grant, Villani, 
and Nyrop thus far, most lawns require no treatment because their grub populations are 
negligible.

When people see Japanese beetle adults on their flowers, they often assum e that their 
yards are infested with Japanese beetle grubs. But Japanese beetles are good flyers and are 
likely to choose an egg-laying site far from the yard in which they are feeding. This is one 
o f several reasons why soil sampling is a prerequisite for sound treatm ent decisions.

The European chafer is by far the most common species o f grub found in upstate New 
York, though the 1994 lawn study did find a greater Japanese beetle grub presence than was 
found in the original study four years earlier.

Results o f the 1990 study o f over 300 Rochester lawns, recently published in Journal 
o f Environmental Entomology 24 (3): 52 I -528 (1995), include a list o f risk factors for the 
European chafer. A lawn is most likely to have dam aging levels o f European chafers present 
if it is less than 20 years old, has less than 30% shade, and is com posed o f more than 30% 
Kentucky bluegrass.

As in 1994, the researchers are seeking volunteers with lawns w ithin 15 miles o f Geneva 
area that can be sampled for grubs. Interested parties should com plete the questionnaire 
found on page two. As a part o f the 1995 study, lawns sampled last year will be revisited 
to track annual variations in grub densities.

Grub sampling was a familiar sight on many 
Geneva lawns last fall. Pictured are Wendy 
Heusler and Steve Hitchcock hard at work.

Sampling will take place slightly earlier this year than last, and those who participate 
in the study will receive maps of the grub populations found on their properties. M anage
ment recommendations will be available for interested hom eowners. ^

Margaret Haining Cowles

WHAT’S NEW ON THE WWW
As of Friday, August 1 1, Cornell University and the 

Agricultural Experiment Station have a public WWW 
site for biological control of pests (insects, diseases and 
weeds). Entitled “Biological Control: A Guide to Natu
ral Enemies in North Am erica,” it can be accessed by the 
URL http://w w w.nysaes.cornell.edu/ent/biocontrol or 
from the Experiment Station Home Page under What’s New and 
Publications or from the Station’s Entomology Home Page.

“The new Web publication is a combination guide, tutorial and educational resource,” said 
entomologist Tony Shelton, who directed the project with Mike Hoffmann of Ithaca under a grant from 
the National Biological Control Institute. The guide was written by Cathy Weeden who accomplished 
the HTML mark-up work with the help of Ben Shelton, John Zakour, and Ron Pool Elaine Gotham 
is responsible for the graphics, page layout and Home Page design.

In the guide, natural enemies are categorized into four subsets: parasitoids, predators, pathogens 
(including antagonists of plant pathogens), and weed feeders. So far, 40 natural enemies are presented 
in fact sheet style using color photographs that are useful for identification purposes.

“We plan to continue expanding to include many representative examples from many different 
systems. It is a living document," said Weeden, who is interested in any comments and suggestions 
on future inclusions for this document. The group intends to apply for future grants. ^

http://www.nysaes.cornell.edu
http://turtle.nysaes.cornell.edu
http://www.nysaes.cornell.edu/ent/biocontrol
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THIS WEEK'S CALENDAR
AUGUST 11 - 18, 1995

EVENTS • MEETINGS” "----
Wednesday, August 16, Noon
Hedrick Hall Conference Room  (G19) 
Geneva Arboretum Association Meeting

LASSO LOOSELY • When using the lasso tool in 
a graphics program such as MacPaint, try this: 
Using the lasso tool, lasso part of an object. 
Then, release the mouse button. The lasso tool 
automatically closes the loop by drawing a straight 
line between where you started and where you 
ended. This saves you from having to tediously 
lasso a large or intricate object.

SEARCH FOR TWO ITEMS AT ONCE • When
using FileMaker, you may want to search for two 
unrelated items at the same time. For example, 
you may want to print a list of the names and 
addresses for all people residing in either New 
York or Indiana. To do this, from the Select 
menu, choose Find. In the dialog box that 
appears, type NY in the state field. Then, from 
the Edit menu, select New Request. In the 
dialog box that appears, type IN in the state field. 
Then, click the Find button. The resulting data 
contains names of people from those two states.

REMOVE PAGE NUMBERS • When using 
Word, you may want to number all the pages in 
a document except the first page. First, create 
your header or footer by selecting Header or 
Footer from the View menu. Then, click on the 
icon for the page number in the ruler area of your 
header or footer window. Then, click the close 
box. From the Format menu, selection Section. 
Click the Different First Page option in the 
Header/Footer section of the dialog box. Click 
OK. Using Print Preview (Command-Option- 
I) to view your document. (If you like what you 
see, don’t forget to save!)

PEOPLE
New Baby:
Congratulations to Holly and Jam ie King on 
the birth o f their daughter, Haily, W ednes
day, August 9. Haily w eighed in at 6 lbs, 9 
oz. Holly is an Accounts Rep in E ntom ol
ogy. M other and baby a rc rk u a g  fine.

CLASSIFIED
FOR SALE: Couch and 2 chairs, matching set, 2 years 
old, hardly used. Light brown. $ 150. Bill x2 15 or home 
@ 716-526-6170.

FOR SALE: Starcraft aluminum boat, 15 ft. with 40 
HP Evinrude, trailer and depth finder. $750. Call Tom 
at x312 or 789-1142.

MISSING: Sanyo cassette radio from Room 216 
SturtevantHall. If someone borrowed it, please return 
to Jing Yu at that location.

FOR SALE: 1987 Nissan Stanza GXE. Excellent 
mechanical condition. Runs great. Body is in excellent 
condition. $3750orbest offer. Tony at x352,789-2310 
or ams5@cornell.edu

FOR RENT: House-3 bedrooms, 2 baths. Available 
September5, 1995-July 15, 1996. Slosson Lane. No 
pets, kids OK. $500/month. Call Carl Aten at 789-7

(BRIEFS, cont.)

i I
1995 HOME LAWN GRUB STUDY

A population study of scarab grubs in home lawns was conducted last year by the 1PM Program 
and the Entomology Department at NYSAES, Geneva. The project is continuing in 1995, and 

I we are seeking more lawns to include in the study. The investigators are Jennifer Grant, Michael 
Villani, and Jan Nyrop. Lawns will be sampled for grubs in late August or September.

A small crew of people will go to each property and inspect soil samples. The procedure 
I takes less than an hour and usually causes no damage. However, if the weather is still dry at that 
I time, some small (< 4-inch diameter) discolored areas may be visible in the lawn temporarily. All 
I participants will receive a map of the numbers and species of grubs found on their property.

(If your lawn was sampled last year, you should have already received a direct mailing.)

1995 HOME LAWN GRUB STUDY QUESTIONNAIRE
Name:_____________________________________________________________________

Home Address:______________________________________________________________

Day Phone:__________________________________________________________________

Evening Phone:______________________________________________________________

1. What size is your lawn? ( Please give approximate lot dimensions or an estimate of
square footage or acreage).________________________________________________

2. Do you have a lawncare service or do you make pesticide applications to your own lawn?

3. When is the last time you know of an insecticide being applied to your lawn? (If you 
know the product name, please note).______________________________________

4. Do you water your lawn: frequently______  occasionally______  never_______

5. Approximately what year was your lawn established (planted)?___________________

6. Please indicate whether you want to be notified prior to our arrival at your home. (We
always knock on the door to notify anyone home at the time).

____ Yes, please call me the day before your arrival.
____ No, knocking on my door is sufficient.
____ Other—explain ________________________________________________

L

Please return this form to Jennifer Grant, IPM Building, NYSAES. 
Thanks for your cooperation!

J

(forking for the Station at
mJmL M Wm w w

The Whale Watch committee is still looking for people to
__ -Sign up far 2-hour shifts August 26 and/or 27 aitheStation's
tent. Pick your area of expertise: Corn roast and tasting, tomato 

tasting, bubble machine, exhibits and microscope, set-up or tear 
down. If you are interested, call Linda McCandless, Kevin Colton, 
Jim Ballerstein, Steve Reiners, Cathy Matteson, or Sandy Antinelli.

Please note : Employees who sign up to work
Sta tion  te n tduringtheWhale 
or 27, will be paid for that 
time. Permission from the su

pervisor is required. If there 
are any questions concerning 
time worked, contact Charie 
Hibbard in Personnel, x203.
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